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Welcome to the latest edition of my monthly Final Cut Studio newsletter for October, 2009.

The goal of this newsletter is to provide information helpful to the interested user of 
Final Cut Pro. This newsletter publishes each month, past issues are available in 
my store. All software references are to Final Cut Studio 2 unless otherwise noted. 

Please invite your friends to visit my website -- www.larryjordan.biz. There you'll 
find daily tips, the latest industry news, and over 450 articles and tutorials to help 
you get the most out of Final Cut!
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WRAP-UP

WELCOME 

Finally, Fall is here! I am not a fan of summer's heat, so it's nice when the weather turns a bit 
cooler. It's raining today in Los Angeles - for most of the world, this is not exciting news. But I 
can't remember the last time it rained around here, so this, too, is very nice.

I read in the papers that the economy is starting to improve - but from my emails, I don't think that 
has filtered down into the world of video production or post quite yet. I am continuing to look for 
ways to create cost-effective training so that as the economy improves, all of us are better 
positioned to find new work and fend off the competition.

(By the way, if you haven't downloaded at least the first episode of my Growing Your Business 
title, this is a great way to jump-start your marketing and client-management efforts.) 

I'm also delighted with two new partnerships we are announcing today - one for training and one 
for a new PowerUP tour. I'll have more the details below.

For now, though, let's turn our attention to some cool new tools and techniques. 

[ Go to Top. ] 

APPLE ANNOUNCES A NEW VIDEO FORMAT - iFRAME 

Earlier this week, Apple announced a new video format - iFRAME - specifically to improve the 
import and editing of HD images. 

http://www.larryjordan.biz/app_bin/Store/catalog/product_info.php?products_id=55


Apple’s support site states:

The iFrame Video format is designed by Apple to speed up importing and editing 
by keeping the content in its native recorded format while editing. Based on 
industry standard technologies such as H.264 and AAC audio, iFrame produces 
small file sizes and simplifies the process of working with Video recorded with your 
camera.

Currently, only Sanyo has announced cameras that support the new format:

SANYO North America Corporation (SANYO) today introduces its high-end Dual 
Cameras, the VPC-HD2000A and the VPC-FH1A, as the world’s first camcorders 
to offer compatibility with iFrame, a next generation video format designed 
specifically to allow users to easily import, edit and share high quality videos.

There are several important notes about this announcement:

�●     At the moment, Final Cut Studio does not support this new format - only iMovie 8.0.5 does.
�●     The new format is designed for computer editing - fast import, fast editing, and square 

pixels, which removes sizing confusion when dealing with still digital images.
�●     The new format shoots a progressive, rather than interlaced, image.
�●     This is the first new video format in a long while, joining the ranks of AVCHD, HDV, and 

AVCCAM
�●     This format does not require transcoding into a different format, such as ProRes, which 

takes time and storage space.
�●     This is not a transcoding format, this format requires camera manufacturers to support it in 

the camera.
�●     The format records a 1/4 frame 1080 image (960 x 540). While more than adequate for 

consumer cameras, it does not compete for image quality with a full-raster HD image.

I am very curious to see if other camera manufacturers adopt the format - and whether Apple 
decides to support it within Final Cut Pro.

For me, the big news is that this is the first of a long series of steps needed to reconcile the 
differences between video and computer formats to reduce the conversions we need to make 
when editing video on our Macs.

Note: I first reported this on my blog. If you haven't checked it out, read it here. 
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LARRY PARTNERS WITH RED GIANT SOFTWARE AND  
SMARTSOUND SOFTWARE FOR NEW POWERUP 2009 TOUR!

I am delighted to announce that we have partnered with two leading 
Final Cut Studio developers - Red Giant Software and SmartSound 
Software - to create a brand new SEVEN CITY PowerUP Seminar 
Tour!

NEW SEMINARS START IN NOVEMBER! 

We are doing two events in November - San Francisco and Las 
Vegas - with the remaining cities following early in 2010.

http://support.apple.com/kb/HT3905
http://www.prnewswire.com/news-releases/sanyo-dual-cameras-are-worlds-first-with-iframe-video-format-64070632.html
http://www.larryjordan.biz/blog
http://www.redgiantsoftware.com/
http://www.redgiantsoftware.com/
http://www.smartsound.com/
http://www.smartsound.com/


Each eight-hour day divides into four segments:

* Trouble-shooting and new features in Final Cut Pro 7  
* Improving the look of your projects 
* Improving the sound of your projects 
* Questions and answers

During each seminar, in addition to in-depth coverage of Final Cut 
Studio, I will also be showing you how to use key software plug-ins 
that can speed your workflow - Magic Bullet Looks and Primatte 
Keyer Pro from Red Giant Software - and - SonicFire Pro 5 with the 
Final Cut Pro plug-in from Smartsound. Plus, there is plenty of time 
for questions and answers. 

A day of training is only $99 - provided you register before the end of 
the year.

I am very excited to be back on the road, meeting with all of you, and sharing ways we can 
stretch our existing resources to get more done with less and look better!

Click here to learn more. Register TODAY! 

\[ Go to Top. ] 

REVIEW: DROBOPRO 

Executive Summary: This is a very impressive unit that deserves a look from any video editor 
that needs fast, secure, expandable storage.

About a year ago, Mark Fuccio, Senior Director of Products & Markets at Data Robotics, sent me 
a Drobo (version 2) to review. [You can read my original review here.]

Drobo, for those of you that haven't heard of it, has an innovative hard disk system that combines 
RAID protection with expandability. 

Normally, a RAID is fixed in size. If you try to add new disks, you need to erase all your data on 
the RAID, change the configuration, then copy all your data back. This is a major pain. However, 
once a RAID is configured, assuming you have a RAID 1, 3, 5 or 6, your data is safe in the event 
one of your hard disks dies.

http://www.smartsound.com/
http://www.larryjordan.biz/seminars
http://www.drobo.com/
http://www.larryjordan.biz/articles/lj_review_drobo.html


Note: RAID 0 provides high-speed storage, but no data redundancy. If you lose a 
drive in a RAID 0 enclosure, you've lost all your data.

The opposite of a RAID is a single hard drive. These are easy to expand by simply buying a new 
hard drive and adding it to your system. However, if one of your stand-alone hard drives dies, 
you've lost all the data on that drive.

As we quickly move from tape-based to tapeless video formats, the need for secure, high-
performance data storage is becoming increasingly critical.

Drobo changed this equation with a system that provides expandable, yet secure, data storage. 
You can increase the size of your storage by simply adding more drives, or replacing existing 
drives with those containing more storage; for example, replacing a 250 GB drive with a 1.0 TB 
drive. Unlike a typical RAID, with Drobo you don't need to worry about reconfiguring your system. 
Drobo automatically rebuilds any missing data on to the new drive.

This was very cool!

However, the older Drobo had two significant failings for video editing: it was very slow and it was 
noisy. 

In April this year, Data Robotics released the DroboPro to address these concerns. And, again, 
Mark asked if I wanted to take a closer look at the unit. Since I love looking at storage, I was 
delighted. Shortly thereafter, two boxes containing a new DroboPro and five hard disks (which are 
sold separately) ranging in size from 250 GB to 1.0 TB, arrived. 

Note: Drobo shipped me Western Digital drives. However, any 3.5" eSATA drive 
from any manufacturer can be used. You can mix and match drive sizes and 
manufacturers with no problems.

For the record, I did my testing on a MacPro 2.93 GHz 4-core, 8 GB RAM, with OS X 10.5.8.

WHAT'S DIFFERENT WITH DROBOPRO 

The DroboPro uses a different connection protocol - iSCSI - which attaches via Ethernet. This 
provides significantly faster speeds. As a MacBook Pro owner, I thought that since Drobo requires 
an Ethernet port, that would rule out my laptop when my laptop is attached to the network, but 
there is a VERY cool workaround that I'll get to in a bit.

The DroboPro replaced their single noisy fan, with a pair of slower speed fans, which drops the 
noise to easily half of the original Drobo. While still noisier than my MacPro, this decrease in 
noise is very welcome. (In fact, they've even made it possible to locate the unit in a different 
room!) 

They also added a new level of data protection that keeps your data safe even if you lose two 
hard drives at the same time. Even better you can switch into, or out of, this protection mode at 
any time without losing any data. 

GETTING SETUP

Drobo has taken a page from Apple's playbook on making your introduction and setup of a 
system a non-threatening affair. The DroboPro is nestled inside a cloth bag, with very friendly 
instructions. If a puppy could be a hard disk, it would look like a Drobo.

Unlike some other RAIDs, you don't need to mount your hard disks on sleds prior to installing 
them into the RAID. Instead you simply remove the magnetic front cover, and slip each hard disk 
into a drive slot.



No screws, nothing tricky. Just follow the pictures in the manual and in less than a minute, all your 
drives are installed. Due to the construction of the unit, it is impossible to install a drive incorrectly.

I installed four 1.0 TB drives and one 250 GB drive for a total of 4.25 TB in storage.

Note: Installation is easy, but follow standard anti-static rules. Touch something 
metal to ground yourself. Avoid excessive movement that could build static 
electricity. A grounding strap isn't necessary, but common sense is. These are the 
drives that will store your very precious data. Treat them carefully.

Another nice touch is that you can put the unit in "Safe Shutdown" mode by unmounting it from 
your desktop, then turning the power switch off. In earlier versions, you needed to do this using 
the Drobo Dashboard (the managment system for all Drobos) .

CONNECTING THE UNIT

The DroboPro supports three connection protocols:

* USB (this redefines the word "slow.") 
* FireWire 800 (cable supplied) 
* iSCSI (using an Ethernet cable, also supplied)

Unlike other hard disks, the power supply is built into the DroboPro - no wall wart, no 
transformers, just a power cord that plugs directly into the wall. However, Drobo recommends 
plugging your unit into a surge protector for safety and I agree with that. Uninterruptible Power 
Supplies (UPS) are a really good idea as well.

Another nice touch is that the power switch is a rocker switch that requires pressing for a second 
or so to turn on, or off, power. G-Technology has done something similar where you need to 
press and hold the power switch for several seconds to turn the unit on. This guards against 
accidental power loss.

Once the unit is turned on, it takes 1-2 minutes to go thru a self-test and connect with the 
computer. Most of the time, this delay is not a problem. However, during my testing as I was 
constantly powering the system on and off, I had to keep reminding myself to be patient. 

The current version of the Drobo Dashboard (v. 1.5.1) supports both older and newer Drobos. In 
fact, all connected units show up in one Dashboard. This makes management of multiple units 
simple.

Note: Drobo tells me, but I didn't test, that you can move the hard disks from your 
older Drobo into the new unit with no problems, and keeping your data intact. This 
makes converting simple - plus, it saves money in that you don't need to buy new 
hard disks.

CONFIGURING THE UNIT

When you first connect the unit and turn it on, the Macintosh OS asks if you want to format the 
drive. This is a BAD idea - be sure to say "No" (by clicking the Ignore button).



Instead, let the Drobo Dashboard format the drive.

Unless you REALLY need PC connectivity, format your drive as HFS+. This provides much larger 
file size support, better Mac integration, and improved performance. FAT32 should only be used if 
you need to attach this to a Windows system.



There are two different storage sizes associated with Drobo:

* The maximum volume size you plan to grow the Drobo to support. 
* The size of your current storage, based on the hard disks you installed. 

In this dialog, you are asked to specify what size you ultimately would like to grow this volume. 
Since I selected 8 TB, this means that at some point - not necessarily now - I expect to have 8 TB 
of drives installed in the unit. This is the size Drobo will configure itself to support. Any storage 
added beyond this will create a second volume (icon) on your desktop.

The next step is to give your drive a name. (I decided on "DroboPro" -- this isn't particularly 
creative, but at least I knew which drive it referred to.)

Once you've made those settings, the drive goes off and formats itself. This took several minutes, 
but FAR less than the 18-24 hours that an XServe RAID used to take. 

When formatting is complete, the drive is ready to use.



The Drobo Dashboard provides continuously updated reports on the status of your unit.

After formatting is done, your Mac asks if you want to use the Drobo for Time Machine backup. 
Since I want to use this for active video editing, rather than backup, I said no. If you want this unit 
solely to backup your data on other drives, say yes.

This chart, available by twirling down the "How is my storage being used?" triangle, shows how 



my disks are allocated. Note that not all disks are the same size. 

Or, another way to look at your system is in the Advanced Settings > Data window.

PROTECTING YOUR DATA

As we have discussed in the past, RAIDS use different levels to protect your data:

* RAID 0 - Fast, no data protection 
* RAID 1 - Slow, if you lose one drive, your data is safe 
* RAID 3 or 5 - Really fast, if you lose one drive, your data is safe 
* RAID 6 - Fast, if you lose two drives at the same time, your data is safe

RAID 0 is at the low end of the cost scale. RAID 6 is heading toward the high end.

While Drobo is not a RAID (in fact, they call their technology "BeyondRAID"), it does offer data 
security. In its default mode, if you lose one drive, your data is safe. Using the Dashboard, you 
can configure it to protect your data in the event you lose two drives.



Go to Advanced Settings > Tools > Settings to change the configuration. When I changed this, 
it took Drobo 15 minutes to reconfigure itself. After that, I can switch between modes with only a 
short period of time (about a minute) for reconfiguration.

There are two trade-offs for the extra security: 

�●     Your system performance slows down about 20% due to the extra data security that is 
being written as you record data.

�●     Your total available system storage drops.

The amount of additional storage space needed for the dual drive security varies depending upon 
the number of drives you have installed. It ranges from 50% for two drive systems, to 13% for 8-
drive units. 

For instance, in my unit:

�●     I installed 4.25 TB of storage
�●     This formatted down to 3.86 TB
�●     Which supported 2.9 TB of available storage in single-drive protect mode



�●     Which supported 2.0 TB of available storage in two-drive protect mode

For me, I would probably stay with the default setting of supporting data integrity with one drive 
failure in order to get the best performance. Your personal level of paranoia may require a 
different conclusion.

TESTING SYSTEM SPEED

This is where the rubber meets the road - and believe me, this is truly squiggle territory.

Four IMPORTANT rules to consider:

�●     Hard disk speed varies based on how empty the drive is.
�●     Hard disk speed varies on how the drive is connected.
�●     As file sizes increase, write speed decreases.
�●     As file sizes increase, read speed increases 

In other words, you can make hard drive test speed numbers be whatever you want. 

So, here's what I did:

�●     The DroboPro was empty for the tests
�●     I used a 2.93 GHz, 4-core MacPro with 8 GB of RAM. 
�●     I downloaded the latest version of the AJA Hard Drive Speed Tester
�●     I used the NTSC DV video format
�●     I set the file size to 256 MB 

Changing ANY of these settings changes the results; so always be a bit skeptical of hard disk 
speed numbers that are too precise.



To try to make sense of the numbers, I set the speed of the Drobo (v2) equal to 1.00. Then, I 
measured the difference in speed of various different hard disks.

In single-disk protection mode, the DroboPro was almost 2.5 times faster in reads and 3.0 times 
faster in writes. These are significant differences in speed.

As another example, I copied 7 GB of files from an internal hard drive to the Drobo and measured 
the results in Activity Monitor. The DroboPro hit speeds in excess of 80 MB/second.

I then transferred 50 GB of files from a FireWire 800 drive to the DroboPro and transfer speeds 
over the course of copying the files were slightly better than 60 MB/second.

In single-disk data protection mode, the DroboPro had data speeds fast enough to support all 
common flavors of HD, support at least four simultaneous data streams for multi-clip work, and 
still protect your data in the event of a drive failure.



This is just excellent.

WORKING WITH SYSTEMS WITH ONLY ONE ETHERNET PORT

Using iSCSI over Ethernet allows for potentially faster speeds than FireWire will support. 
However, if you only have one Ethernet port, and need access to a wired internet, this is a 
problem.

However, there is a very cool work-around -- you can connect the DroboPro to your network data 
switch. Using a switch, you can access both the Internet and your DroboPro from a single cable.

This has two benefits: 

�●     You can locate the DroboPro up to 300 feet from your computer (to reduce noise, for 
example)

�●     You can locate the DroboPro where you have space, rather than on your desktop.

This is NOT network-connected storage. You can only connect the DroboPro to one computer at 
a time. However, I'm currently connected to the unit via my network switch and the Drobo is 
located in another room. 

I tested the data rates of transferring via a switch. If you use a 10/100 Ethernet switch, you'll only 
get about 11 MB/second - too slow for video. If you use a Gigabit switch, I was getting data 
transfer rates around 80 MB/second.

In order for this to work, however, you'll need to give the unit a static IP address. The Drobo 
website explains how, however, it doesn't warn you that the IP address needs to be in the same 
subnet as the rest of your gear. The default IP address of the unit won't work.

To determine your subnet address, go to System Preferences > Network and note the IP 
address of your system. Enter the same first three sets of numbers; for example, 192.168.123. -- 
then enter a unique number for the last set of numbers. 

I'm currently connecting to the DroboPro with the unit placed in another room, connected through 
my network switch, and doing real-time video editing using P2 media. The ability to connect to the 
unit thru my standard Ethernet cabling, yet providing speeds that support video editing, is very, 
very impressive. 

CONCLUSION

I am very impressed. Drobo has done an excellent job listening to the needs of video editors. If 
data protection combined with performance are important to you, you need to look closely at this 



unit.

The DroboPro retails for $1,499 with no drives. Data Robotics has bundles with hard drives that 
range in price from $1,999 for 4 TB of storage to $3,499 for 16 TB of storage. 

Two things I wish for the future, one small and one big:

�●     They need to change the Advanced Controls button to go to the Tools window, not Data. 
The Data window looks nice, but Tools contain all the settings we need to change.

�●     They need to make the system directly attach to the network so that multiple computers 
can access the unit -- even if only one computer can write to the unit at a time. 

Other than that, the DroboPro is very cool.

UPDATE - Oct. 15, 2009

Chi-Ho Lee took my numbers to task:

You wrote a nice review of the Drobo Pro as a physical unit but I'm confused by 
your refusal to list real read/write speeds of the unit. In fact, you took great pains to 
justify why you don't list hard speed numbers. Your speed chart made absolutely 
no sense. Other drive reviews lists the read/write speed at 0% capacity and then at 
90% capacity. Then the readers can judge for themselves what are the relative real 
world speeds.

I agree with you that one can fudge the numbers a bit on these speed tests but no 
reputable manufacturers' speeds are off more than 10% of their listed speeds. After 
reading your well written, detailed review of the DroboPro, I have no idea whether 
it's capable of capturing uncompressed 1080i 10bit, 8bit, ProRes or any other 
codec. 

You said you ran the AJA speed test, please post the AJA speed results instead of 
converting it into this nebulous non-nonsensical chart.

Your newsletters are great in general but this review is missing the most important 
piece of information and hence my frustration.

Larry replies: These are excellent comments.

The only reason I did not list the speeds was that as the file sizes changed from 128 MB to 1 GB, 
the disk speeds changed dramatically. Since there is no way in Final Cut to adjust the size of the 
files being transferred, I realized that simply publishing the speeds would be a meaningless 
exercise.

However, I'm happy to go back and add a table indicating the speed settings that I got in my 
tests. Here it is.

Drobe Speed Test Table 

System Write Speed Read Speed 
Drobo (v2) 25 MB/s 33 MB/s 

External USB (2) 19.8 MB/s 20.5 MB/s 

DroboPro (Dual-disk 
protection mode) 53 MB/s 48 MB/s 



External FireWire 800 single 
drive 64 MB/s 83 MB/s 

DroboPro (Single-disk 
protection mode) 78 MB/s 81.4 MB/s 

Internal MacPro hard disk 102 MB/s 98 MB/s 

NOTES

�●     Speeds tested using the AJA Disk Speed Test software
�●     Test files were 256 MB in size
�●     The DroboPro was empty at the time of the test 
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LARRY PARTNERS WITH DV CREATORS 
TO PROVIDE HANDS-ON TRAINING IN FINAL CUT STUDIO 

DV Creators was the first company in the world to provide 
hands-on training with the first release of Final Cut Pro in 
1999. Since then, they have been acknowledged as one of 
the world's leading training organizations.

I've been teaching at their facility for the last several years and, recently, we decided to work 
more closely together to provide hands-on training that includes - and goes beyond - what's 
available in normal Apple training courses.

Our goal is to continue to provide cost-effective, state-of-the-art, hands-on training to help you 
make the most of Final Cut Studio and related applications.

You can learn more by visiting here: www.dvcreators.net/events. 

[ Go to Top. ] 

CHECK OUT MY VIDEO TUTORIALS - AND NEW BUNDLES!

I'm already working on new tutorials for Final Cut Pro 7, in the meantime, take a look at over 
FIFTY tutorials and bundles. These short, focused video training clips can solve your technical 
questions and get you up and running faster than anything else. 

I have four different bundles - SAVE 30% when compared to buying each tutorial separately! 

�●     My Favorite Final Cut Pro Tutorials
�●     Video Compression
�●     Soundtrack Pro Bundle #1
�●     Soundtrack Pro Bundle #2

With 50 tutorials available, you can find the complete list of my video tutorials here.

http://www.dvcreators.net/
http://www.dvcreators.net/events
http://www.larryjordan.biz/training/online_bundles.html
http://www.larryjordan.biz/training/online_bundles.html
http://www.larryjordan.biz/training/online_bundles.html
http://www.larryjordan.biz/training/online_bundles.html
http://www.larryjordan.biz/training/online_tutorials.html


You can find the complete list of my video bundles here -- SAVE 30%!

With almost 50 titles to choose from, and priced at only $4.99 each, there's sure to be at least a 
couple that can help you solve the problems you're having. Each title runs 5-10 minutes and can 
be instantly downloaded. 

More titles coming every month! Take a look and order today! 

[ Go to Top. ] 

 
REVIEW: EUPHONIX CONTROL SURFACES

Recently, Richard McKernan, Director of Western Regional 
Sales for Euphonix, invited me to their LA offices to take a look 
at a suite of new products designed for video and audio editors. 
These are:

* MC Control 
* MC Mix 
* MC Transport 
* MC Color - to be released in about a month.

Euphonix got its start in the high-end of the audio market, providing audio mixing consoles and 
control surfaces that would incite lust in the eyes of anyone who felt they just HAD to mix 48 
channels of live audio.

They had a couple of these large boards set-up and I spent 30 minutes just looking at them and 
sighing deeply. However, the last time I did a 48-channel mix was... um... never, so I reluctantly 
left the room to discover something that was much more interesting. The Euphonix Artist Series of 
control surfaces.

A control surface is designed to work in conjunction with a computer in that no audio or video 
signals flow through the control surface. Instead, it provides remote control to the editing 
functions on your computer. 

Sitting next to these three units was JC Haydon, product manager for Euphonix. Talking with JC 
is like a high-dive into the deep end of the audio pool - the guy really knows his stuff.

QUICK PRODUCT OVERVIEW

MC Mix ($1,399) is an eight-
channel audio control surface 
that is specifically designed for 
audio mixing. It can run stand-
alone or work with MC Control or 
MC Transport. The dark monitor 
strip at the top contains high 
resolution OLEDs for 
displaying volume, parameter 
and track names, and values. 

http://www.larryjordan.biz/training/online_bundles.html
http://www.larryjordan.biz/training/online_tutorials.html
http://www.euphonix.com/
http://www.euphonix.com/
http://www.euphonix.com/


MC Control ($1,499) is a hybrid 
system providing four channels 
of audio mixing (on the left), full 
transport control (on the right), 
and a LCD touch screen monitor 
with programmable soft-keys and 
visual feedback in the center. 
Audio channels can be switched 
in banks to control multiple audio 
tracks. 

MC Transport ($399) provides 
full transport controls with 
programmable soft-keys, but no 
audio mixing. It contains both a 
high-precision shuttle and jog 
wheel; along with seven 
navigation keys, six 
programmable soft-keys, and a 
small OLED monitor in the top 
left. It also supports audio mixing 
by assigning fader control for an 
autio track to the jog wheel.  
 
You can use the MC Transport 
alone, or in conjunction with up 
to four MC Mix units or an MC 
Control. 

MC Color ($1,499) is a three 
track ball system designed to 
simplify working with Color 1.5. It 
offers high-resolution trackballs, 
trackwheels, touch-sensitive 
encoders and programmable 
keys in a slim-line design

All four units support the HUI and 
Mackie interface control protocols, as 
well as the Euphonix EuCon ethernet control protocol. 

THE CONTROL SURFACE DIFFERENCE

The benefit to using a control surface is that you can do things with them faster than you can with 
a mouse and keyboard. And, as someone who has used many, many audio consoles in his life, I 
was anxious to give it a try.

So, Euphonix graciously loaned me an MC Control for a week to play with. I eagerly took it home, 
plugged it into my MacPro and started playing with it.



Like the DroboPro I discussed earlier, Euphonix gear connects via Ethernet. Final Cut Studio (3) 
includes drivers for this gear, so connecting and configuring takes about five minutes. (Be sure to 
allow time to download and install the latest drivers and, if necessary, firmware.) Even better, you 
can run your network, DroboPro, or Euphonix connections thru the same Ethernet switch, so that 
even a single port MacBook can access all of these through a single Ethernet cable connected 
from the computer to the switch.

However, after installing and upgrading all the drivers, I found myself having more questions than 
answers. First, I discovered that Final Cut Pro supports control surfaces but not for everything. 
FCP supports transport (playback) controls, keyboard shortcut and macros, and mixing in the 
audio mixer. FCP does not support control over filters or motion effects. (More on this in a minute).

Soundtrack Pro is similar to Final Cut. The implementation was better, but nowhere near as 
glossy as what you can do with an MC Control system in Logic. One important benefit is how it 
provides a very complete touch-screen implementation of the surround sound panner. 

Note: By default, Soundtrack Pro sets the shuttle to move in 1 frame increments. 
Although you can change this using the STP toolbar so that the playhead moves in 
smaller chunks, I found this setting had no impact on how MC Control moved the 
cursor. I could not find any setting that would allow the playhead to move smoothly. 

Further, I discovered that as a keyboard-and-mouse editor, I had a lot of muscle-memory 
behaviors I needed to change. Instead of grabbing for the mouse to move the playhead, for 
example, I needed to grab the transport shuttle wheel.

However, I could see the potential for how this system could make my work easier - but there was 
no way I could write a detailed review of on using this system in the time I had that would do it 
justice. The problem wasn't the unit - the problem was the operator of the unit - me.

It was the little things: knobs can be turned or pushed. Which should I do? 



  
  
  
  
  
  
  
  
  
  

[Answer: Select a track on the touchscreen. Press the knobtop like a button next to 
the word "pan" you will now have pan controls for that track. ]

Should I push a button on the screen or the soft-key beneath it?

[Answer: The soft-keys on the bottom of the screen relate to the labels above them 
on the screen.] 

Um, what can I do with this thing? 

[Answer: With the MC Control, you can write fader automation, perform edits, and 
multiple keyboard shortcut commands packaged in macros, as well as use the 
touchscreen to pan. And the surround panner is very nice, too.]

By the way, in working with this unit, I've become an enthusiastic fan of soft-keys - these are very 
helpful in getting more done in less time. 

A DIALOG

So, to solve this conundrum caused by an inexperienced operator, I sent JC Haydon, Euphonix 
product manager, a series of questions that would help me explain the significance of their 
products without requiring me to be an expert in them. Here is our conversation, along with some 
additional comments.

Larry: What can a control surface do that can't be done with a keyboard and mouse? 

JC: Euphonix media controllers not only let you to use multiple keyboard shortcuts 
or [build] macros with a single button press, but also give you hands-on control 
over multiple faders and pans simultaneously for keyframing audio. The jog wheel 
offers precision control in navigating your project and can be assigned to many 
different functions. Media controllers like MC Control and MC Transport are first 
and foremost designed to give you tactile access and control of your media 
applications, and really bring the functionality out of the computer and onto your 
desktop. Also, both MC Control and MC Transport can control audio faders in Final 
Cut Pro. 

Larry adds: This ability to create keyboard macros can be a big timesaver. MC 
Control allows you to control up to four faders or pans at once, while MC Mix can 
control up to eight. MC Transport has no audio controls at all. As for precision 
jogging, FCP worked as mentioned. STP, however, did not. No matter how I 
changed the nudge factor, the playhead still moved stiffly and in steps. 

Larry: What Apple applications are optimized for control surfaces?

JC: The new Final Cut Pro, Soundtrack Pro and Color, as well as Logic Pro, all 
natively support Euphonix’ EuCon control protocol. One of the unique features of 
the EuCon protocol is that it is application aware, and automatically updates all 
surface displays, soft-keys and controls to match the selected application. Although 
these four Apple applications natively support EuCon, Euphonix media controllers 
can actually control any application via soft-keys to trigger keyboard shortcuts, so 
you can use even use them to streamline your workflow in applications like 
Photoshop, Motion and others.

Larry adds: Keep in mind that the level of support between these four applications 
varies from deeply integrated with Logic to only partially supported by Soundtrack 
Pro.



Larry: Which control surface is best suited for Final Cut Studio?

JC: All Euphonix media controllers are well suited for FCS, but most editors will 
probably find MC Control and MC Transport the most interesting, as they feature 
soft-keys that are customizable to suit the way an editor wants to work with Final 
Cut Studio, as well as offering a jog wheel to speed up navigation and editing. With 
its eight faders and pan knobs, MC Mix is an audio controller that many top editors 
have adopted for keyframing audio tracks. The new MC Color, on the other hand, 
is a dedicated [color] grading surface for Apple Color. What all of these controllers 
share is Euphonix’ EuCon Ethernet control protocol, and they can each be used 
standalone or in conjunction with other Artist Series media controllers.

Larry: What can you do with a control surface in Final Cut Pro that you can't do with a keyboard 
and mouse?

JC: MC Control ships with a template [in the EUCon software, illustrated above] 
that has a navbar of soft-keys for Browser, Viewer, and timeline commands. When 
you press the soft-key for each, FCP selects that window, and the MC Control 
updates with context sensitive commands. These can be programmed to suit your 
workflow, but the product ships with highly effective, preprogrammed keys. MC 
Transport also ships with preprogrammed keys and can be customized with two 
layers of soft-keys. These soft-keys not only trigger everything from traditional Final 
Cut Pro quick keys to custom macro commands, but these soft-keys can also 
switch the functionality of the jog wheel on the fly, giving you high-resolution, tactile 
control over a host of functions.

A few examples:

Example 1: Rough edit

The Keyboard sequence of commands is “Command+4, up/down arrow keys, 
Enter” to load clip into the Viewer. Then “J, K, L or left/right arrow keys” to locate 
the In point. Then “I” to mark the In. Then “F10” to perform the edit.

MC Control/MC Transport performs the same sequence with the “Preview 
previous” soft-key which loads the clip into the Viewer. Use the jog wheel to find 
the In point. Press “In” soft-key. Press “Edit” soft-key.



Benefit: Reduces 10+ keystrokes to three soft-keys.

Example 2: Effect and motion favorites

Once favorites are assigned key commands in FCP, they can be called singularly 
or in multiples to reproduce looks. This is ideal for color correcting multiple clips in 
a timeline from the same reel with the same color problems, or applying effects 
plus motion to a lower third or reveal.

The Keyboard sequence of commands is “down arrow” to find clip, “x” to mark, 
“option a” to select, then “control shift 2”, “control shift w”, and then additional 
keystrokes for more combinations.

MC Control/MC Transport performs the same sequence with the “next clip” soft-
key, then one macro soft-key to perform the sequence of “x, option a”, and any 
combination of effect and motion favorites.

Benefit: Quickly move through timeline to normalize effects, corrections, and 
motion reveals across clips.

Example 3: Audio keyframes

Keyframing audio in FCP, or adjusting clip volume is a process of drawing with the 
pen tool, or dragging clip volume.

MC Control: To adjust clip volume, simply jog over the clip and use the fader(s) to 
adjust volume. When you let go, you will set clip gain. To keyframe, turn audio 
keyframes on with a soft-key and press play. As you move the faders you will write 
keyframes. 

Having multiple faders lets you keyframe multiple clips simultaneously, allowing 
you to mix them in real time with greater precision for a more organic result. 

Example 4: Custom wheel functions

You can use the wheel on MC Transport and MC Control in Final Cut Pro to jog 
through the timeline, and then with the touch of a button assign the wheel to adjust 
clip audio levels, trim an edit, or move a clip in Final Cut Pro. Switching over to 
Soundtrack Pro, the jog wheel allows me to jog through my timeline like in Final 
Cut, and then assign the wheel via my Soundtrack Pro soft keys to trim the In point 
and outpoint of a clip, fade in and out and more.

Larry: Why does Logic work so well with a control surface and Soundtrack Pro does not?

JC: In 2006 Logic Pro 7 was the first application into which Apple integrated 
Euphonix’ EuCon control protocol. Every release of Logic has brought deeper 
EuCon integration and new functionality. The new Final Cut Studio, including 
Soundtrack Pro, is the first version to natively integrate EuCon. As with Logic, 
additional functionality and deeper integration will come with new releases.

Larry adds: This, to me, is the key point Final Cut editors need to consider. If you 
are spending a great deal of time in Logic, the integration between the software 
and Euphonix is deep and helpful. However, the integration between Soundtrack 
Pro and Euphonix is far more rudimentary. This is NOT Euphonix' fault, rather the 
problem is in how Apple allows third-party gear to connect into STP. While we can 
hope for future improvements, Apple is notoriously reluctant to share any thoughts 
about what it is planning for the future.



Larry: How should a video editor decide which control surface is best for them?

JC: Any video editor performs thousands of repetitive key command combinations 
over the course of an edit. Both MC Control and MC Transport can speed the 
editing process and are flexible enough to be programmed to suit an individual’s 
workflow. MC Transport’s weighted jog wheel and high resolution shuttle ring may 
appeal more to any editor working with repetitive processes of creating and refining 
edits in the timeline, while MC Control is a full range audio/video solution.

Larry: What is the new MC Color?

JC: MC Color is a color grading 
surface that has been specifically 
designed for Apple Color, with a 
host of features optimized for the 
Apple Color workflow. Euphonix 
worked directly with Apple on the 
new API for Color, and MC Color 
is the first grading surface that 
makes use of it. And as part of 
the Artist Series family, MC Color 
makes use of the same compact, 
slim-line designs as Euphonix’ other media controllers that makes it very portable 
and easy to integrate into any desktop setup.

Larry: Why does Color benefit from a control surface?

JC: The Color interface is really simplified and made more accessible with a 
control surface. Using a mouse allows you to control only one parameter at a time, 
while having two hands on MC Color allows you to adjust contrast or color balance 
and contrast in multiple zones simultaneously. Color correction has traditionally 
been performed with control surfaces, and MC Color makes the type of control 
offered by more expensive solutions more financially and ergonomically accessible.

Larry: What's the biggest hurdle that traditional keyboard and mouse people, like me, need to 
overcome to use a control surface successfully?

JC: Euphonix control surfaces can speed and enhance any media professional’s 
workflow. If you have a deep knowledge of an application, you can simplify the way 
the application is presented to you with customized labels and colors on soft-keys 
that describe the action you will perform. This can be anything from a one off key 
command to a macro that moves media through multiple windows of FCP, and 
applies effects to the resulting clip in the timeline. One or two editing sessions 
should be all it takes to see the benefits.

Larry adds: Here, I think, marketing has, perhaps, misdirected JC's answer. The 
biggest hurdle is that we need to teach our hands an entirely different way of 
editing. For some of us, that will be easy, for others, more difficult. Especially for 
editors that have memorized hundreds of keyboard shortcuts, not grabbing the 
keyboard will be difficult.

LARRY'S FINAL THOUGHTS

I spend most of my time in Final Cut and Soundtrack -- none in Logic. For me the key question is: 
can these products help me edit so much faster and better that they become worth the cost.

And here the cost isn't the products - for what they do they are very reasonably priced - its the 



cost in my time and effort to retrain how my brain thinks and my hands move.

And the answer is different, depending upon the software we are using.

�●     For Final Cut Studio editors using Color, MC Color is a great new product that makes 
working with Color fast and accurate.

�●     For Final Cut Pro editors, using the programmable soft-keys, macro creation, smooth 
transport, and its attractive low price makes MC Transport worth the time it will take to 
learn to use the system.

�●     For Soundtrack Pro editors, the jury is out on MC Control. The unit has a great feel, solid 
construction and very flexible software. The limitation, currently is with Soundtrack Pro.

Depending upon your needs, each of these is worth considering.

[ Go to Top. ] 

DIGITAL PRODUCTION BUZZ IS GOING TO GV EXPO

This year, GV Expo returns to the Walter E. Washington Convention Center, in Washington, DC, 
for three days of conferences, exhibits, and meetings. I'll be taking the Digital Production BuZZ to 
the event to provide on-going coverage in special BuZZ broadcasts, starting December 1.

If you are anywhere close to Washington, DC, visit us at the show. The trade show allows plenty 
of time to meet with vendors, the conferences provide extensive training on a number of software 
packages, as well as insight on the industry. 

For details on what The BuZZ is doing at the show, click here.

For details on GV Expo, click here. 

[ Go to Top. ] 

PASSING THOUGHTS

iPHONE FINAL CUT PRO APPS

Diana Weynand, famed author of Apple's Final Cut Pro textbooks, has released 
an iPhone app that provides easy access to keyboard shortcuts in Final Cut Pro 7.

Learn more here.  
http://www.weynand.com/wt/ikeystogo:-final-cut-pro-7-%11-iphone-app/

[ Go to Top. ] 
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http://www.weynand.com/wt/ikeystogo:-final-cut-pro-7-%11-iphone-app/


AND ANOTHER iPHONE APP

A number of folks sent me the link to another iPhone app for Final Cut Pro: FCP 
Shortcutz, from Pixel Pilot Productions.

UPDATE - Oct. 15, 2009

Tom Wolsky sent this in:

Speaking of iPhone apps, I’m not sure if you mentioned this one before, but I think 
it’s a great little production app: ActionLogPro.

www.andris.co.uk/actionLog.html

It’s logging software on the iPhone. It exports by emailing the log list as HTML, 
ALE, and XML.

Larry replies: Thanks, Tom. 
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BUG IN COMPRESSOR 3.5

Bruce Nazarian sent this in:

Using Share from FCP 7 makes better Blu-ray Discs than using Compressor 3.5. 
Why?

Because, apparently, Apple BROKE something in CMP 3.5 when it comes 
to Blu-ray Discs encoding, that remains UNBROKEN in FCP7.

So, if you share DIRECTLY from FCP7, your video looks great. If you Share and 
Send to Compressor, or just use Compressor to make a Blu-ray Discs, the results 
are flawed.

[ Go to Top. ] 

CAN'T FIND FCP RESCUE

Jared sent me the first of many emails about my comment recently mentioning FCP Rescue.

You mention under troubleshooting the FCP Rescue program, but perhaps the 
Attic one is better. I can’t find the link to download this program anywhere. Will it 
run on FCP 6 (or the FCP7 just released)? Where can I get it?

Larry replies: You can't. The developer has discontinued developing it. Better choices are 

http://bit.ly/11en6Z
http://bit.ly/11en6Z
http://www.andris.co.uk/actionLog.html


EditGroove's UserMatic and Final Cut Assistant from Peake Professional.

UPDATE - Oct. 15, 2009

Tom Wolsky sent this in:

Another excellent replacement for FCP Rescue is Preference Manager, from 
Digital Rebellion. It does all the apps. 

Larry replies: Thanks. 
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SMOOTHCAM IN FCP 7

Chris Roberts, from the UK, sent me the following tip:

I've recently been running classes using FCP 7 on Leopard. When I demonstrate 
some SD DV footage (both PAL and NTSC), the SmoothCam filter appears to have 
the effect of destabilizing the material. HD (HDV, DVCPRO HD and ProRes) 
footage seems fine, and previous demos on FCP6 were flawless using the same 
material. If I transcode the the footage to ProRes, again all seems fine.

Larry adds: I haven't seen this, but the idea of transcoding to ProRes to fix problems is very 
appealing. Keep this in your bag of tricks.
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SUPPORTING XDCAM EX ON FCP 5

Gary Belitt needed to find a way to get XDCAM EX codecs installed on Final Cut Pro 5. He was 
in an academic situation that did not have the budget to upgrade. Here is his workaround:

We have found a way to get the codecs from my home system, which has FCP 6; 
and, we can now read and edit the XD Cam EX files in FCP 5.

�●     Go to the library on the Mac that has the latest version FCP
�●     Navigate to the Quicktime folder
�●     Open the Quicktime folder and copy the Apple HDV codec and place it the 

same folder on the machine that does not have it.

(For safety, I saved the original Apple HDV codec that was in the older system in 
case the newer codec didn't work, as they are the same name.) 

Everything seems to work fine now, but as you said my colleague can only read 
the files with After Effects or Quicktime. He cannot open them in Premiere.

UPDATE - Oct. 15, 2009

http://editgroove.blogspot.com/2009/04/usermatic-v103-released.html
http://www.finalcutassistant.info/
http://www.digitalrebellion.com/pref_man.htm


Eric Mittan writes:

He might have better luck using a Perian plugin to read your video. 
One built specifically for XDCam can be found here:

blog.lib.umn.edu/mcfa0086/discretecosine/164630.html

Though unsupported, I've found them to be pretty stable. And in the 
format of a Quicktime plugin, they are easy to uninstall if you have 
problems. Simply remove them from the /Library/Quicktime folder on 
your hard drive

Larry replies: Thanks, Eric. 
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EXTERNAL BLU-RAY BURNERS

Bruce Nazarian send me the following link to a Blu-ray burner that works with Macs.

www.digistor.com/Products/DIGISTOR-Self-Powered-Solutions
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A NEW STOCK FOOTAGE SITE

Russell Tafarella writes:

A friend and I recently started up a Stock Footage website that I thought you might 
be interested in. It's www.unlimitedstockmedia.com. Our site is really affordable 
and is on membership basis and you can buy a day pass for $49 and download to 
your hearts content. Or you can go monthly for $197. All the clips are HD and were 
shot with RED One and Sony Cinealta cameras. We're really excited about it and I 
just thought I'd pass this along to you.
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ANOTHER WAY TO AVOID USING TAPE

Ken Cooper sent this in.

DGS delivery is a new way to send files to a cable network. I did some research 
and this is what I learned:

www.dgfastchannel.com/network.htm

http://blog.lib.umn.edu/mcfa0086/discretecosine/164630.html
http://www.digistor.com/Products/DIGISTOR-Self-Powered-Solutions
http://www.unlimitedstockmedia.com/
http://www.dgfastchannel.com/network.htm


Might be of interest to you since many TV and Cable outlets are using this 
instead of the overnight Beta Tape for National Spots. I would only do it if we had 
more spots 
every month.
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READER MAIL

FIGURING OUT THE BEST WAY TO INSTALL FINAL CUT PRO 7

Jorge Marsal writes:

I have the FCS 2 Academic installed...purchased FCS 3 Academic through the 
school/church account...only $299.

Since there is no upgrade...are my only 2 options to install it separately, or to 
uninstall FCS 2 and then install FCS 3?

I love LiveType, so without an upgrade I know I loose it...should I keep the older 
version installed and will I be able to import into FCP as usual?

I also use FXFactory Pro and other plugins...will I have access to those, or have to 
install them all over again into FCP 7?

I know I’m asking a bunch of things here, but I’m confused as to the best course to 
take with less stress and time since I don’t have a natural upgrade. I’ve also 
considered not installing FCS 3 at all.

Larry replies: Jorge, the easiest thing to do is simply install FCS (3) on top of FCP 2. This also 
allow you to retain LiveType. I would NOT uninstall FCS 2 unless you have problems. If you 
ERASE your hard disk to do a completely clean install, you'll need to reinstall LiveType, and all 
your third-party plug-ins, to get them back.

While there is not an upgrade PRICE for the Academic version, the process of moving from FCS 
2 to FCS (3) is the same as an upgrade.

Additionally, all your existing third-party filters and plug-ins will move automatically into the new 
version.

The only thing you can't do is have both FCS 2 and FCS (3) on your system at the same time. 
One or the other, but not both.
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THOUGHTS ON SNOW LEOPARD

Ben Balser writes:

As for Snow Leopard and FCS'09, I have been doing some serious editing with it 



for a few days now, as have two large scale clients of mine, and we are finding 
things go faster with Snow Leopard. Photoshop launches in about half the time, as 
does FCP and other apps, but not all apps. Rendering "seems" to be a tad bit 
faster. Encoding I'm finding some minor speed improvement, depending on what 
you're encoding. As for stability, none of us have found any issues. I've run FCS 
(3), Final Cut Server (v1.5), and Snow Leopard as straight updates on 4 different 
systems so far, and so far, we're finding no problems. 

You didn't mention in the newsletter the issue with QTX Pro when upgrading to SL. 
You have to make sure to tell you SL upgrade to keep QT7. QTX removes the 
preferences and Export functions we all relied on in QT7 Pro. It will move QT7 to 
the Utilities folder, and QT7 will still have all the old Pro features. But as of now, 
there seems to be no real QTX Pro at all. And it's Share menu is super limited 
compared to FCP, Motion, and Compressor.

As for the user interface improvements [in FCS (3)], let's look at some hard data; In 
the past three years FCP has grown by leaps and bounds to just over 50% of the 
professional post-production market, when it's competitors have lost good amounts 
of market share and have done major revamps of their products. Not sure what this 
says, but I find it very interesting. Maybe, if it ain't broke, don't rebuild it from the 
ground up? We'll see what the future updates to FCS'09 bring with SL, eh?

Also, I strongly recommend against running Final Cut Studio 2 on Snow Leopard. 
I'm seeing lots of problems with my clients.

Larry replies: Thanks, Ben, for writing.
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THOUGHTS ON FINAL CUT PRO 7

Roger Watling writes:

I found an issue with opening a sequence in FCP 7 that was created in 6. 
 
All was well except for the -100 speed changes, I just used the field reversal plug in 
which fixed it. 
 
I'm sure this is a simple basic thing but one that could easily be overlooked when 
an old project is re-exported.

Larry replies: Thanks!
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MORE THOUGHTS ON FCP 7

Marcus writes:

The elimination of LiveType as a standalone is a big mistake. More Apple 
arrogance. 
I love LiveType. It's footprint is small and it runs fast. 



I like using it for FCP and it's less intimidating to lower end users that I tutor.

The other thing is that it is faster than Marquee and that makes it a nice quick title 
animator for Avid. 

(I am amused that nearly 20 years after Avid's introduction, FCP now let's you 
name the markers. Not impressed.)

The rest, well if you still have to re-render in order to view element composites on 
the timeline then you're still in the stone age which is why I prefer the faster Avid to 
editing HD. For SD I consider it a wash. 

Larry replies: Thanks, Marcus.

Here's my thought on LiveType. It's a great program, but it was written so long ago that re-writing 
it to fully support Snow Leopard is not worth the effort it would take Apple. So, they decided to let 
it die a slow death now, by supporting it in FCP 7 but not including it in the package, rather than 
kill it abruptly in the next release.

Just speculation, but that's what seems to make sense to me. 

UPDATE - Oct. 15, 2009

Philip Hodgetts adds:

I think it ultimately simply became redundant when they added the glyph animation 
features to Motion and fixed the way Motion dealt with color change on LiveFonts 
(the main reason I continued to champion LiveType over Motion for LiveFonts). But 
Motion 4 deals with it right (to my thinking) so ultimately LIveType didn't really have 
a future. Nothing much unique left for it. The technology all lives on, just inside 
Motion.

And I've been a big LiveType fan. 

Larry replies: Sigh... me, too. 
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AND STILL MORE THOUGHTS ON FCP 7

Alan Day writes about running FCP 7 on OS X 10.6.1:

I have had duplication of Audio automation data from one track (Music) onto 
another track (Narration) where it was not supposed to be! Using Edit > Remove 
attributes on the narration zeroed out the rubber banding. However, despite the 
Automation being visibly unchanged on the MUSIC track (NOT having done 
anything to it) playback sounded as if it too was zeroed out! Clicking once on the 
Music track then caused the Automation (Rubber bands) to visually jump what I 
had just heard - i.e. zeroed out.

I have also had times when video clips, played back in the time line even AFTER 
they have been removed or “covered” with another clip on a higher layer! 
Sometimes they simply don’t play in the canvas after being edited into the 



timeline ... this “feels” like a render engine problem as I have seen this problem 
emerge right after a clip refused to render.

Soundtrack "Pro" is still as unstable as it ever was. Zero improvement noticed with 
existing (reported) STP2 faults still unfixed!

Here is one for the newsletter! When outputting a program in ProRes I got this 
helpful little message. (attached screenshot) ... about 90% through a 3 hour render. 
Nothing at all was found to be output. Tried 7 times so far ...

I tried relinking the media to find and illuminate unused files and templates but that 
didn't help either. Nothing was off line - I checked.

Larry replies: Alan, thanks for the update.

By the way, while I am not yet running Snow Leopard, I am using Soundtrack Pro almost every 
day with no problems. I remain very uncomfortable recommending running FCS (3) on Snow 
Leopard. 

And I agree, that your dialog box is somewhat less than helpful...!
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MISSING MEDIA THAT ISN'T MISSING

Graham Taylor writes:

On the subject mentioned in a recnet issue by Philip Best on Missing Audio 
Waveforms, I wondered if timeline Video Thumbnails [in FCP 5.1.4], some of which 
in certain projects show ‘media offline’, could be resurrected by deleting the 
Thumbnail Cache Files? 

I tried deleting the Thumbnail Cache but to no avail. Oddly enough, if I Match 



Frame to a timeline clip whose thumbnail shows ‘media offline’, the clip appears in 
the viewer as normal. But if I overwrite it, frame-for-frame, the thumbnail remains 
‘media offline’. If I put a razor blade anywhere in the clip, I get the correct 
thumbnail! But if I Roll trim back to the head of the clip, I get ‘Media Offline’ in the 
thumbnail again. Could you suggest what I should try to resolve this minor problem 
please?

Larry replies: Try trashing your Final Cut Pro preferences and see if that helps. Here's an article 
that explains how: www.larryjordan.biz/articles/lj_trouble.html
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CONVERTING HD FOOTAGE TO SD

Pia Sawhney writes:

I'm capturing footage on ProRes 422 and it looks great. But I've been trying to 
output to DVD, and I'm getting all tangled up in compression. Any clues on how I 
might send ProRes footage to DVD? Once I master this workflow, I'll be ready to 
start -good news, for sure.

The settings I'm now using are ProRes 422 (HQ) 1920 X 1080 30p 48k. I chose 
that option on Final Cut 7 after checking online; seems 1920 is the best option for 
29 fps.

Larry replies: Pia, thanks for writing!

You have several options. Keep in mind that DVDs are ALL SD, not HD. This means that you 
need to down-convert your HD footage to SD before burning to a DVD.

While Blu-ray Discs are HD, they can't be created in DVD Studio Pro.

If all you need to do is burn ONE sequence to DVD, without any fancy menus, use File > Share > 
DVD from inside FCP 7. (Though see Bruce Nazarian's note above in Passing Comments about 
a Blu-ray bug in Compressor 3.5.) 

If you need to create a DVD with menus, use File > Export > QuickTime movie.

Create a self-contained movie using your ProRes format.

Bring that ProRes file into Compressor and apply the DVD Best Quality setting that most closely 
matches the TOTAL length of all your videos. This process will down-convert your HD footage to 
SD.

Bring the now-compressed MPEG files into DVD Studio Pro and author your DVD as normal.
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URGENT DEINTERLACING?

http://www.larryjordan.biz/articles/lj_trouble.html


Lauren Dunbar writes:

I have a DVCPROHD 720p project (shot 30 and 60 fps) and have to mix in some 
footage shot as HDV 1080i (30 fps). I know that FCP v.6 does a nice job with the 
Open Timeline of mixing footage, but don't I need to de-interlace the HDV footage? 
Do I need to change the pixel aspect ratio to "square"? Or does FCP just make that 
work in the Open Timeline?

Will I get the best results by sending through Compressor before editing? Or is it 
best to de-interlace through a FCP sequence set as 1440x1080i????

Larry replies: Lauren, these are all good questions.

1. You don't need to deinterlace.

2. You ESPECIALLY DON'T need to change the pixel aspect ratio.

3. You don't need to resize to 1440 x 1080.

4. Yes, you'll get "better" results using Compressor - but ONLY if you know what 
you are doing.

5. Here's the easy way - just edit your HDV footage - as is - into your DVCPRO HD 
sequence. If it looks good to you, use it.

6. Here's the longer way - convert all your HDV footage to DVCPRO HD using 
Compressor. If you decide to go this route, use the Compressor setting of 
DVCPRO HD 720p/60.
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PROBLEMS SHARING AUDIO

Robin Harris writes:

Came across an interesting bug producing a narrated web short. Once I had the 
narration the way I wanted it, I round-tripped it to STP, adjusted the levels and ran 
the pops filter and saved it back to the timeline. All good.

Ran it through the new Share option to create a QT H.264 (.mov) version and half 
way through the audio dropped several decibels. About a minute later it dropped 
further and stayed low until the end. Checked the timeline audio - no problem. Ran 
through Compressor to another .mov, still had the problem. Then I Shared to the 
YouTube mp4 and - no problem!

Since it was a web project, the YouTube Share settings worked out fine. Running 
all this on a MacPro 1,1 quad-core with 12 GB RAM and 10.5.8.

Larry replies: Thanks for the tip, Robin.

I've noticed that when I share a file using FCP 7 (OS X 10.5.8) about 50% of the time I get an 
"Share Disabled " message. The only way I get it to disappear is to restart the computer.



The situation is so consistent that I've given up using Share and simply Export instead. I can 
export faster than I can restart the computer to reset Share. 
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POTENTIAL PROBLEM ROUND-TRIPPING TEXT TO STP

Another note from Ben Balser:

There may be a problem with STP, if you have text generator clips, when round 
tripping from FCP, and back to FCP, the new Sequence created, text generator 
clips will look text wrapping totally, and have to be re-typed.

Larry replies: Thanks, Ben.
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ANOTHER AUDIO PROBLEM

Joel writes:

I'm helping out a friend, trying to finish his edit.

When I load up his project the audio files don't relink, they remain grayed out on 
the timeline. When I select the file to see the item properties, it says xyz.wav file is 
missing. But when I try to reconnect the media, it can't find that xyz.wav file 
because it's looking for some other name.

Have you ever seen this?

Larry replies: Nope.

I've seen FCP looking for an audio render file, but not a WAV file. If a reader has any ideas, 
please let me know and I'll pass them along.

[ Go to Top. ] 

A CAUTIONARY TALE

Duncan writes:

Since I know you like to warn people about the perils of upgrading, I thought I'd 
share my own little story. It's not disastrous (at least, not yet) but anyway...

I noticed that iTunes has graduated to version 9. I didn't want to risk installing a 
version.0 of anything, so I waited for version 9.0.1 - I read the little blurb about all 
the improvements, fixing of bugs, etc, so I thought - why not?



I installed version 9.0.1 and then discovered that iTunes won't open without at least 
Quicktime 7.5.5. I've been staying at 7.3.1, because I still have Final Cut 5.1.4. (I 
have the Academic version, so going higher was not an economical or convenient 
option for me at the time).

So now, as well as missing out on all the Apple goodies of the last two years, I'm 
iTunes-less as well, so I'm probably going to take the plunge this weekend and get 
Snow Leopard and the new FCS. I had been planning on doing this by the end of 
the year anyway, but I wish I could have done it on my terms and not Apple's. I'm 
not in the middle of a project, so no great loss.

Larry replies: First, never upgrade QuickTime without upgrading Final Cut at the same time - they 
work very closely together. This is especially true if you are working with older versions of FCP 
which were released years before the current version of QuickTime.

There is no way the Final Cut development team knows what's going to happen with QuickTime 
year's in the future - therefore, they can't support something in software that they don't know 
about.

Second, I am not opposed to upgrading - I simply urge a little caution that you not upgrade the 
instant a new version is announced.

Third, keep in mind that upgrading to Snow Leopard and FCS (3) means you need to have an 
Intel-based Mac. If you are running on a G-5, Leopard (10.5) is as high as you can go.

Here's an article I wrote a while back that explains my philosophy on upgrading. 
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AUDIO MIX-DOWN PROBLEMS IN FCP 7

Remy writes:

I am editing a weekly 7-minute program for the Web since 2 years, exporting the 
time-line in a QT movie, DV-Pal ( I am european) and then using Squeeze to make 
a flv file. Since I upgraded FCS 3, the Squeeze step is much more longer, double 
time in fact, 2 hours instead of 1. I was wondering if this could be connected to the 
audio mix-down delay in FCP 7?

Thanks Larry for your tutorials, I learned so much from it ! 

Larry replies: Remy, thanks for writing. I can't think of anything in FCP 7 that would affect 
compression time in Sorensen Squeeze.

I assume you are exporting a completed QuickTime movie using File > Export > QuickTime 
Movie, then opening that QT movie in Squeeze for compression. In which case, once the file is 
exported, FCP is totally out of the picture and all the delays are caused by Squeeze. 

Make sure, if you've upgraded to Snow Leopard as well as FCP 7, that you upgrade Squeeze as 
well.
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http://www.larryjordan.biz/articles/lj_upgrade_philosophy.html


EDITING VIDEO FROM THE CANON 5D

Marty Nowak writes:

Have you worked with any footage from the Canon 5D yet? I'm having issues 
editing a few clips shot on the Canon 5D. I've edited all kinds of footage on my 
system before including Red footage without a problem. But I cannot successfully 
play anything on the time line without it stuttering or stopping due to dropped 
frames. I lowered the RT to Safe, to Unlimited all sorts of things but nothing is 
working. Any advice?

Larry replies: Thanks for writing, Marty.

You need to transcode the H.264 file the 5D generates into ProRes HQ. The best way to do this 
is using Compressor. It will take time, but it will solve the problem.

Editing the H.264 files directly is an exercise in frustration.
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THE CASE OF THE MISSING MONITOR

David Ransley writes:

Thought I'd share this experience with your readers who use AJA Kona cards. 
Recently I up dated my Apple Final Cut Studio 2 and AJA Kona software and 
drivers and came across a frustrating problem. I lost the ability to choose three of 
my Digital Cinema Desktop Preview settings.

�●     Digital Cinema Desktop Preview-Main -- OK -
�●     Digital Cinema Desktop Preview -- not available
�●     Digital Cinema Desktop Preview-Full-Screen -- not available
�●     Digital Cinema Desktop Preview-Raw -- not available

At first I thought it was my AJA Kona update but as it turns out it probably was an 
update from Apple.

I removed my AJA Kona LH software and rebooted my system, and opened up 
FCP and my Digital Cinema Desktop Preview settings returned. I tried re-installing 
the AJA Kona LH software and drivers from 7 back to 6.5 and then 6.0 and in every 
case three of the Digital Cinema Desktop Preview settings would disappear. Now I 
suspect it was an update from Apple that is causing the problem.

Larry replies: David, it may be an Apple problem, but I think not.

When you only have one computer monitor attached to your system, your only choice for 
monitoring is Digital Cinema Desktop Preview.

When you add a second, computer, monitor, three more choices appear:



* Digital Cinema Desktop Preview 
* Digital Cinema Desktop Preview-Full-Screen 
* Digital Cinema Desktop Preview-Raw

These choices are only available when your computer sees that it has two computer monitors 
attached.

By installing the AJA drivers, you MAY be telling the system that there is only one computer 
monitor, plus a video monitor, attached. At which point, the three options you mention will 
disappear.
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PROBLEMS WITH QMASTER

Mohamed Selim, in Cairo, writes:

Let me just start off by saying that without your help, i would not be the Editor i am 
today. Thank you for everything.

I have a problem in my work flow and i figured you would know how to solve it.

I setup a cluster between two 8 core MacPros, I'm trying to convert a 5 min (6 GB) 
file with the "DVD-Best quality 90 minute" preset, but i customized it to de-interlace 
the file. When i submit it process the file on one core on the "B" machine, not the 
"A" machine (service controller)...

I tried many times and always it does the same. In addition, when i change the 
preset to WEB-High, its acts as expected..it splits the file into 20 segments and 
process on all cores of both machines. 

Larry replies: Mohamed, if you are using Final Cut Studio 2, QMaster is notoriously unreliable. To 
the point that I no longer recommend using it.



Instead, you are far better off using System Preferences > Qmaster to enable multi-processor 
compressing on a single multi-core MacPro. To do this, click the Options for selected service 
and set the number of processors you want to use for compression. The more you select, the 
slower other active applications will run. 

The other gating factor to using QMaster successfully is that your host system needs to send your 
video files to the other compression system, which can often take longer than just compressing 
the files on a single system.

I have been told this problem has been much improved in Final Cut Studio (3), but I have not yet 
had time to test it.
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SEEING FIELDS

Tom Burden writes:

Avid allows you to see the individual fields of a frame of video on your computer 
monitor( you don't need an external monitor to see flash frames), has Final Cut 
added this feature yet?

Larry replies: If you set the zoom setting in FCP to 100%, in either the Canvas or Viewer, you can 
see fields as an interlaced image. 
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WRAP-UP 

WRAP-UP

Well, that's about it for this month. 

For current news and in-depth interviews on what's happening in our industry, be sure to listen to 
the Digital Production BuZZ every week. In fact, you can put the free player on your website! 

�●     Visit our store and buy some of our latest tutorials. 
�●     Or, sign up for one of my monthly workshops. 

Also, please continue sending your comments and questions. I love hearing from you and enjoy 
the conversations that develop around these stories.

Until next month, take care, and edit well.

http://www.digitalproductionbuzz.com/LiveThisWeek
http://www.larryjordan.biz/training/online_tutorials.html
http://www.larryjordan.biz/sem/workshops.html
mailto:larry@larryjordan.biz?subject=Newsletter comments


Larry

Subscribe to Larry's FREE

Monthly Newsletter! 

Email:    
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Legal Notes

The newsletter is free -- but does require a subscription. Please invite your friends 
to sign up at www.larryjordan.biz/newsletter.

To unsubscribe, simply send me an email and I'll remove you from the list. This list 
is not sold, rented, or bartered. The only person who knows you are on this list is 
me.

The information in this newsletter is believed to be accurate at the time of 
publication. However, due to the variety of possible system and software 
configurations, the author assumes no liability in case things go wrong. Please use 
your best judgment in applying these ideas.

The opinions expressed in this newsletter are solely those of the author. This 
newsletter has not been reviewed or sanctioned by Apple or any other third party. 
All trademarks are the property of their respective owners and are mentioned here 
for editorial purposes only.

Text copyright 2009 by Larry Jordan & Associates, Inc. All rights reserved. This 
newsletter may not be reproduced or published in any way, in whole or in part, 
without specific written permission from the author. 

Links to my home page, blog, or website articles are welcome and don't require 
prior permission. 
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